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Chapter 14 Microwave Office 
Interface

Sonnetの Microwave Office Interface (MOI) はAWR社の Microwave Office 6.0 
以上と Sonnetのｿﾌﾄｳｪｱとの完全に統合された “ ﾘｸｴｽﾄﾍﾞｰｽのｿﾙﾊﾞｰ ”の
ｲﾝﾀﾌｪｰｽです。このｲﾝﾀﾌｪｰｽは、 Sonnet を EM解析ｴﾝｼﾞﾝとして使いなが
ら、完全に Microwave Officeの環境の中にいることができたり、EM解
析を実行する前に Sonnet の環境の中で回路を編集できます。どちらの方
法も、解析結果は容易に Microwave Office の環境の中に統合的に戻され
ます。3つめのｵﾌﾟｼｮﾝは Sonnetののﾌﾟﾛｼﾞｪｸﾄを、Microwave Office の
ﾌﾟﾛｼﾞｪｸﾄの中の EM構造として使用することができます。

NOTE:  Microwave Office Interface は図形ﾌﾟﾛｼﾞｪｸﾄのみｻﾎﾟｰﾄします。  Sonnet
からﾈｯﾄﾘｽﾄﾌﾟﾛｼﾞｪｸﾄを変換することはできません。
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このﾏﾆｭｱﾙは、ﾕｰｻﾞが SonnetとMicrowave Officeの両方を使い慣れてい
ると仮定しています。そうでない場合は、ﾕｰｻﾞが学びたいｿﾌﾄに用意さ
れている解説をご覧ください。Sonnetを初めてお使いになるﾕｰｻﾞは、
Sonnet Tutorial manualのﾁｭｰﾄﾘｱﾙを一読されることをお勧めします。これ
は、印刷物のﾏﾆｭｱﾙ、または Sonnet ﾀｽｸﾊﾞｰから PDF形式で入手できま
す。

System Requirements
このｲﾝﾀﾌｪｰｽは Windows 2000とWindows XPでお使いになれます。この
ｲﾝﾀﾌｪｰｽは Linux Red Hat Enterprise 3.0 ｼｽﾃﾑ上で動作しますが、その
ﾌﾟﾗｯﾄﾌｫｰﾑでは動作確認はしていません。AWR社の Microwave Office 
Interfaceでは、 AWR社の Microwave Office 6.0 以上が必要です。

Installation
Microwave Office Interfaceは Sonnetのｲﾝｽﾄｰﾙ時に自動的に ｲﾝｽﾄｰﾙされま
す。しかし、Microwave Office Interface のｲﾝｽﾄｰﾙがうまくできない場合
は、次のようにｲﾝﾀﾌｪｰｽをｲﾝｽﾄｰﾙします。

1  Sonnet ﾀｽｸﾊﾞｰをｵｰﾌﾟﾝします。

 Sonnet ﾀｽｸﾊﾞｰのｵｰﾌﾟﾝの方法は、Sonnet Tutorialの 15 ﾍﾟｰｼﾞの "Innoking 
Sonnet"をご覧ください。

2 ﾀｽｸﾊﾞｰのﾒｲﾝﾒﾆｭｰから Admin ⇒ MWOffice Interface ⇒ Install を選択しま
す。

Microwave Office Interface がｲﾝｽﾄｰﾙされ、このｺﾏﾝﾄﾞは使用できなくなり
ます。

NOTE:  Sonnetのｲﾝｽﾄﾚｰｼｮﾝの一部としてMicrowave Office Interface がうまく
ｲﾝｽﾄｰﾙされると、このｺﾏﾝﾄﾞは使用できなくなります。
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Uninstall
Sonnetのすべてをｱﾝｲﾝｽﾄｰﾙせずに、 Microwave Office Interface をｱﾝｲﾝｽﾄｰﾙ
したい場合は、次のようにします。

1 Sonnet ﾀｽｸﾊﾞｰをｵｰﾌﾟﾝします。

 Sonnet ﾀｽｸﾊﾞｰのｵｰﾌﾟﾝの方法は、Sonnet Tutorialの 15 ﾍﾟｰｼﾞの "Innoking 
Sonnet"をご覧ください。

2 ﾀｽｸﾊﾞｰのﾒｲﾝﾒﾆｭｰから Admin ⇒ MWOffice Interface ⇒ Uninstall を選択し
ます。

 Microwave Office Interface がｱﾝｲﾝｽﾄｰﾙされます。ｱﾝｲﾝｽﾄｰﾙが完了すると、
Admin ⇒ Microwave Office ﾒﾆｭｰで使えるｱｲﾃﾑは Install ｺﾏﾝﾄﾞだけになりま
す。 Sonnet は、 Microwave Officeでは既に EM ｼﾐｭﾚｰﾀとして選択できなく
なります。Microwave Officeの設計にあるすべての EM 構造は、
Microwave Officeの EM ｼﾐｭﾚｰｼｮﾝｴﾝｼﾞﾝである EM Sightに変換されます。

Licensing
 Microwave Office Interface は Sonnet Lite と Sonnet LitePlusと共にご利用い
ただけます。 Sonnet Level2 Basic以上のｵﾌﾟｼｮﾝとしてご購入いただけま
す。この機能が使用可能であるかご不明の場合は、御社のｼｽﾃﾑｱﾄﾞﾐ
ﾆｽﾄﾚｰﾀにお尋ねください。

Microwave Office Interface Overview
Microwave Interface にはいろいろな用途があります。

• Microwave Officeの中で EM 構造や回路を編集し、その回路
をｼﾐｭﾚｰｼｮﾝしたい時には Sonnet の解析ｴﾝｼﾞﾝ、emを実行する
ことができます。

• Sonnetの project editor を起動し、図形を編集して Microwave 
Office の環境から解析を実行することができます。

• ﾕｰｻﾞの EM 構造を Sonnet のﾌﾟﾛｼﾞｪｸﾄにｴｸｽﾎﾟｰﾄし、Sonnet の
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環境で解析し、解析が完了した時に Sonnet のﾌﾟﾛｼﾞｪｸﾄを
Microwave Office にｲﾝﾎﾟｰﾄできます。
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下図は Microwave Office (MWOffice) Interface の概観と、使用されている
ﾌﾟﾛｸﾞﾗﾑとﾌﾟﾛｼﾞｪｸﾄが互いにどう関連しているかを示しています。

 Microwave Office Interface は AWR社の Microwave Office の EM Socket を使って、Sonnetの解析ｴﾝｼﾞﾝ em
を “ ﾘｸｴｽﾄﾍﾞｰｽのｿﾙﾊﾞｰ ”としてご提供します。 Microwave Officeの中で EM 構造を編集するか、または
Sonnetの project editorの中で編集するか選択できます (AWRの Native Editor )。

Microwave Officeの EM 構造を編集する時は、図形は解析するために Sonnet へ送られ、解析結果のみが
Microwave Officeに送り返されます。

図形の編集に Sonnetの project editor である Native Editorを選択した場合、 EM 構造は Sonnetに送られま
す。変更事項は Sonnetの中で行われ、図形は Microwave Office に送り戻され、 Microwave Office の
ﾌﾟﾛｼﾞｪｸﾄの一部として格納されます。解析が Microwave Officeで実行されると、Sonnetのﾌﾟﾛｼﾞｪｸﾄは解析
のために Sonnet に送られ、解析が終了すると解析結果は戻されます。

AWR’s
Microwave

Office

em
Sonnet’s analysis engine

MWOffice Editor

    
Native Editor

Either Editor

Geom
etry

Geometry

Response Data

Geom
etry

Sonnet’s Project 
Editor
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Selecting Sonnet as your EM Simulator
次の 2つの方法のうち 1つを使って Sonnet を EM ｼﾐｭﾚｰﾀとして選択する
ことができます。

Opening a New EM Structure

Microwave Officeの中で " New EM Structure " をｵｰﾌﾟﾝする時は、どの解析
ｴﾝｼﾞﾝを使用したいかというﾌﾟﾛﾝﾌﾟﾄが表示されます。Sonnet を選択する
には次のようにします。

1 Microwave Officeの中でMicrowave Office のﾌﾟﾛｼﾞｪｸﾄをｵｰﾌﾟﾝします。

左にﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞｳｨﾝﾄﾞｳ の表示されたMicrowave Office ｳｨﾝﾄﾞｳが表示
されます。

ﾌﾟﾛｼﾞｪｸﾄ
ﾌﾞﾗｳｻﾞ ｳｨﾝﾄﾞｳ
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2 ﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞｰの EM Structuresを右ｸﾘｯｸし、表示された
ﾎﾟｯﾌﾟｱｯﾌﾟｳｨﾝﾄﾞｳから “New EM Structure” を選択します。

 New EM Structure ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽが表示されます。

3  “Sonnet 3D Planar Electromagnetic Simulator” ﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸします。

これにより、 Microwave Office内での電磁界ｼﾐｭﾚｰｼｮﾝの解析ｴﾝｼﾞﾝとして
Sonnetの emが選択されます。

4 ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの上部にある Nameﾃｷｽﾄ入力ﾎﾞｯｸｽに新しい EM Structureの
所望の名前を入力します。

これで Microwave Officeのﾌﾟﾛｼﾞｪｸﾄの EM構造が指定されます。

Sonnet
Checkbox
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5 新しい EM Structure を作成するために、Create ﾎﾞﾀﾝをｸﾘｯｸし、この
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽをｸﾛｰｽﾞします。

新しい構造がﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞに表示され、以下のように Microwave office 
ｳｨﾝﾄﾞｳにﾌﾞﾗﾝｸの基板が表示されます。この例題の新しい構造は “Demo
Filter”です。

Selecting Sonnet for an Existing EM Structure

Microwave Officeのﾌﾟﾛｼﾞｪｸﾄで、既にある EM構造のために Sonnet を
EM ｼﾐｭﾚｰﾀとして選択するには、次のようにします。

1 Microwave Officeで、 Microwave Office ﾌﾟﾛｼﾞｪｸﾄをｵｰﾌﾟﾝします。

左にﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞの表示された Microwave Office ｳｨﾝﾄﾞｳが表示されま
す。

The new EM 
Structure
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2 ﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞの所望の EM Structure を右ｸﾘｯｸし、表示された
ﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Set Simulator” を選択します。

Select a Simulator ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽが表示されます。
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3 “Sonnet 3D Planar Electromagnetic Simulator” ﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸします。

4 OK ﾎﾞﾀﾝをｸﾘｯｸして変更事項を適用し、ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽをｸﾛｰｽﾞします。

これで、Sonnetを EM ｼﾐｭﾚｰﾀとして選択することは終了です。

Editing in Microwave Office
Sonnetを解析ｴﾝｼﾞﾝとして選択すると、どこで EM構造を編集するかを選べます。
つまりMicrowave Office 、または Native Editorとしての Sonnetの project editorで
す。次の節ではMicrowave Officeの環境でﾕｰｻﾞの構造を編集する方法を説明しま
す。

ﾕｰｻﾞの EM構造に Sonnetに特有の thick metal、誘電体ﾌﾞﾘｯｸ、autogrounded ﾎﾟｰﾄ
のような上級の機能を使用していない時に、Microwave Officeで EM構造を編集
します (Sonnetのみ使用可能な機能の全体のﾘｽﾄは 255 ﾍﾟｰｼﾞの "Translation Issues"
をご覧ください )。

Microwave Office をｴﾃﾞｨﾀとして使用する時は、Microwave Office ﾒﾆｭｰと
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの中のMicrowave Office Interfaceに用意されている解析ｺﾝﾄﾛｰﾙを使
えますが、解析周波数と実行ｵﾌﾟｼｮﾝを調整できます。解析を要求すると、
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Microwave Officeに入力された EM構造の図形の仕様が Sonnetに送られ、解析ﾃﾞｰﾀ
の結果だけがMicrowave Officeに戻されます。

Selecting Microwave Office as the EM Structure Editor

Microwave Office はすべての EM構造にﾃﾞﾌｫﾙﾄのｴﾃﾞｨﾀです。前に Sonnetをｴﾃﾞｨﾀに
選択してる場合は (249 ﾍﾟｰｼﾞの "Editing in Sonnet’s Project Editor"を参照 )、次のよ
うにｴﾃﾞｨﾀを切り替えます。

1 Microwave Officeのﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞの所望の EM Structure を右ｸﾘｯｸし、表示され
たﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options”を選択します。

 Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが表示され、下図のようになっているはずです。

2 MWOffice Editor ﾗｼﾞｵﾎﾞﾀﾝをｸﾘｯｸして、 EM構造のｴﾃﾞｨﾀとして
Microwave Office を選択します。

EM構造のすべての編集と変更はMicrowave Office ｴﾃﾞｨﾀで行われます。
EM構造をｸﾘｯｸすると、編集を行うMicrowave Office ｳｨﾝﾄﾞｳの右に回路が
表示されます。これにより、Microwave Office と Sonnetの両方で使用可
能な機能が限定されます。 Microwave Office と Sonnet間で変換しない機能
のﾘｽﾄは 255 ﾍﾟｰｼﾞの "Translation Issues" をご覧ください。

ここをｸﾘｯｸして
Microwave Office 
をｴﾃﾞｨﾀとして選
択します。

General Tab
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TIP
ﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞで EM 構造をﾀﾞﾌﾞﾙｸﾘｯｸすると、Microwave Office か Na-
tive Editorかどちらか選ばれた方のｴﾃﾞｨﾀがｵｰﾌﾟﾝします。

Changing the Fill Type

金属の図形に Sonnet で使用される充填ﾀｲﾌﾟを指定することができます。
Sonnetのﾃﾞﾌｫﾙﾄの充填ﾀｲﾌﾟは階段状の充填です。この場合、以下のよう
に小さなｾﾙが曲部や斜めの縁部を近似するために使用されています。

ｺﾝﾌｫｰﾏﾙﾒｯｼｭの充填と斜め線状の充填のﾀｲﾌﾟは、曲がった縁と斜めの縁
をそれぞれより正確にﾓﾃﾞﾙするために使用されます。  Sonnetの ｴﾃﾞｨﾀで
は、1つの図形ごとに充填ﾀｲﾌﾟを適用できますが、 Microwave Officeで編
集している時は、ｸﾞﾛｰﾊﾞﾙかﾛｰｶﾙかまたは図形ﾍﾞｰｽにこれらの充填ﾀｲﾌﾟ
を適用することになります。充填ﾀｲﾌﾟと、それらが Sonnetでの
ｻﾌﾞｾｸｼｮﾆﾝｸﾞにどう作用するかについては、 51 ﾍﾟｰｼﾞの第 4章
"Subsectioning "をご覧ください。

Setting Sonnet Fill Type Globally

Microwave Officeのﾌﾟﾛｼﾞｪｸﾄですべての既存のEM構造と新しいEM構造に
ｺﾝﾌｫｰﾏﾙか斜め線状の充填を適用するには、次のようにします。

2つの図形は同一のものです。下
の図形の黒い輪郭は Sonnetで
ﾕｰｻﾞが入力した図形を表してい
ます。上の図形は emで解析され
た実際の金属導体です。ご覧の
ように曲がった縁部を近似する
ために “階段状 ”が使用されてい
ます。
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1 Microwave Officeのﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞの “EM Structures” ｴﾝﾄﾘｰを右ｸﾘｯｸし、
表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options” を選択します。

 EM Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが画面に表示されます。

2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞの Mesh ﾀﾌﾞをｸﾘｯｸします。

ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞ は下図のように表示されるはずです。

3 ｾﾙの充填ﾀｲﾌﾟを設定するために Conformal Meshか Diagonal Fillか、所望
のﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸします。

この設定が Microwave Officeのﾌﾟﾛｼﾞｪｸﾄのすべての EM構造のすべての
金属導体のﾃﾞﾌｫﾙﾄとなります。この設定は EM 構造毎にﾛｰｶﾙに
(234 ﾍﾟｰｼﾞの "Setting Sonnet Fill Type Locally"を参照 )または図形毎に変
更することもできます (235 ﾍﾟｰｼﾞの "Setting Sonnet Fill Type for a Single 
Polygon" を参照 )。

4 OK ﾎﾞﾀﾝをｸﾘｯｸして、変更事項を適用し、ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞをｸﾛｰｽﾞします。

この充填ﾀｲﾌﾟは新しい EM 構造がこの Microwave Office ﾌﾟﾛｼﾞｪｸﾄの中で
作成される時にはいつも、ﾕｰｻﾞの選択に対してﾃﾞﾌｫﾙﾄとなります。
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Setting Sonnet Fill Type Locally

1 ﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞの所望の EM Structures名を右ｸﾘｯｸし、表示された
ﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options” を選択します。

Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが画面に表示されます。

2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞの Mesh ﾀﾌﾞをｸﾘｯｸします。

ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞ は下図のように表示されるはずです。

3 Project Defaults ﾁｪｯｸﾎﾞｯｸｽが選択されていたら、これをｸﾘｯｸしてｸﾘｱにします。

このﾁｪｯｸﾎﾞｯｸｽが選択されると、 Global の設定が使われます。このﾁｪｯｸﾎﾞｯｸｽを
ｸﾘｱにするとこの EM構造に対して選択できます。

4 この EM構造のすべての金属導体にｾﾙの充填ﾀｲﾌﾟを使用するために
Conformal Mesh か Diagonal Fillかどちらかの所望のﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸし
ます。
この図形にそのﾒｯｼｭを使用したいだけなら、以下の “Setting Sonnet Fill Type for a 
Single Polygon“をご覧ください。

5 OK ﾎﾞﾀﾝをｸﾘｯｸして変更事項を適用し、ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞをｸﾛｰｽﾞします。
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Setting Sonnet Fill Type for a Single Polygon

1つの図形のﾒｯｼｭのﾌﾟﾛﾊﾟﾃｨを変更するには、次のようにします。

1 所望の図形の上でｸﾘｯｸして、それを選択します。

図形の頂点が強調表示され、それが選択されたことを示します。

2 表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰの “Mesh/Material Properties” を右ｸﾘｯｸして、
これを選択します。

 Conductor Properties ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽが画面に表示されます。

3 Conductor Properties ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽのMesh Options ﾀﾌﾞをｸﾘｯｸします。

 Mesh options が表示されます。
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4  Use default properties ﾁｪｯｸﾎﾞｯｸｽが選択されていたら、これをｸﾘｯｸして使
用不可にします。

これですべての設定が可能になり、この EM 構造のﾃﾞﾌｫﾙﾄの設定を上書
きできます。

5 この EM構造のすべての金属導体にｾﾙの充填ﾀｲﾌﾟを使用するために
Conformal Mesh か Diagonal Fillかどちらかの所望のﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸし
ます。

これで選択された図形にｾﾙの充填ﾀｲﾌﾟが適用されます。

6 OK ﾎﾞﾀﾝをｸﾘｯｸして変更事項を適用し、  Conductor Property ﾍﾟｰｼﾞを
ｸﾛｰｽﾞします。

Controlling the Subsectioning (Meshing)

Sonnet では各図形のｻﾌﾞｾｸｼｮﾝの中にｾﾙをどのように組み込ませるかを
ｺﾝﾄﾛｰﾙできます。これはﾊﾟﾗﾒｰﾀ “X Min”、 “Y Min”、 “X Max” 、 “Y Max”を
使って行います。これらのﾊﾟﾗﾒｰﾀは各図形について変えることができ、
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ある図形には粗い分解能、他の図形には細かい分解能を設定することが
できます。これらのﾊﾟﾗﾒｰﾀは下図のように Microwave Officeでは
Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞのMesh ﾀﾌﾞにあります。

上の "Changing the Fill Type "で示したように、これらのﾊﾟﾗﾒｰﾀをｸﾞﾛｰﾊﾞﾙ
かﾛｰｶﾙまたは特定の図形について設定することができます。ﾊﾟﾗﾒｰﾀとそ
れらが Sonnetのｻﾌﾞｾｸｼｮﾆﾝｸﾞでどう作用するかについては、57 ﾍﾟｰｼﾞの
"Changing the Subsectioning of a Polygon" をご覧ください。

Controlling the Analysis Frequencies

解析周波数の範囲と、 Sonnetの解析に使う周波数ｽｨｰﾌﾟの種類を
Microwave Officeの Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞからｺﾝﾄﾛｰﾙできます。Microwave
Officeで要求された点で解析するか、全域または部分的な周波数帯域で
Adaptive Band Sweep を実行するかに限られます。

Sonnetの Adaptive Band Synthesis (ABS) は指定された周波数帯域で細かい
分解能の解析をします。Emは最初と最後の周波数で回路を解析します。
Emは他の周波数点で繰り返し解析し、その周波数帯域内の
S ﾊﾟﾗﾒｰﾀﾃﾞｰﾀ に適合した有理多項式を決定します。適合した有理多項式
が許容誤差で完成すると、指定された周波数帯域の周波数応答が計算さ

Subsectioning
Controls
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れます。 Microwave Office のｼﾐｭﾚｰｼｮﾝに 4 ないし 5つ以上の周波数点が必
要な場合、 ABSを使う Adaptive Sweep が所望の結果を得る最も効果的な
方法です。

TIP
 ABS ｽｨｰﾌﾟを使用している時は、emは 10個のﾃﾞｰﾀ点とほぼ同じ計算時間
で、 300個のｼﾐｭﾚｰｼｮﾝﾃﾞｰﾀを生成します。

ﾛｰｶﾙｺﾝﾄﾛｰﾙで、ｸﾞﾛｰﾊﾞﾙ周波数より少ないﾃﾞｰﾀ点しか求めていない時に
は、特にMicrowave Officeで Local frequency ｺﾝﾄﾛｰﾙを使うことを避けた
いでしょう。 Microwave Office は Local Frequencies で得たﾃﾞｰﾀを使い、
Global frequency ﾃﾞｰﾀを補間します。Sonnetの ABS ｽｨｰﾌﾟは数個の約 300の
ﾃﾞｰﾀ点を生成することができるので、 Global ｺﾝﾄﾛｰﾙで周波数を指定し、
Sonnetの解析からのﾃﾞｰﾀを使用する場合のみ効果的で高精度です。

例えば、 Microwave Officeで Global frequency ｺﾝﾄﾛｰﾙが 1 から 10 GHz まで
0.1 GHz毎に解析するように設定されたとします。これには 91の周波数点
で、EM構造の解析が要求されます。また、Local ｺﾝﾄﾛｰﾙが 1から 10 GHz
まで 11の周波数点だけを指定し、ﾕｰｻﾞがこの場合、1から 10 GHzまで
全周波数帯域で ABS ｽｨｰﾌﾟを設定したとします。 Microwave Officeで
Simulate ⇒ Analyze ｺﾏﾝﾄﾞが選択されると、Sonnet analysis のｴﾝｼﾞﾝ、emは
1から 10 GHzまで ABS ｽｨｰﾌﾟを行い、この周波数帯域に約 300 のﾃﾞｰﾀ点
を生成します。しかし、戻されるﾃﾞｰﾀは下図のように 1 GHz 毎に 1から
10 GHzまでの間の11の周波数点だけです。 Microwave Office はこれらの周
波数点の間を補間し、 Global Frequency 点を生成します。従って、ﾕｰｻﾞの
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EM構造を解析する最も効果的な方法は、 Microwave Officeの Global 
ｺﾝﾄﾛｰﾙで所望するすべての周波数を指定し、Sonnetの emで ABS ｽｨｰﾌﾟ
を設定することです。

Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞの Sonnet Options ﾀﾌﾞの Adaptive Sweep Settings から
Sonnetの解析用の周波数ｺﾝﾄﾛｰﾙを指定します。このﾍﾟｰｼﾞをｵｰﾌﾟﾝするに
は、EM構造の上を右ｸﾘｯｸし、ﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options”を選択し、
表示された Property ﾍﾟｰｼﾞで Sonnet Options ﾀﾌﾞをｸﾘｯｸします。この設定と
使用方法は以下で説明します。

Use Adaptive Band Synthesis:Sonnetで EM構造の解析時に ABS ｽｨｰﾌﾟを実
行するためにこのﾁｪｯｸﾎﾞｯｸｽを選択します。ABS ｽｨｰﾌﾟは約 300のﾃﾞｰﾀ点
を生成しますが、 Microwave Office で要求されたﾃﾞｰﾀ点だけが Sonnetから

AWRの
Microwave Office  
91 の Global ﾃﾞｰﾀ
点と 11 の Local
ﾃﾞｰﾀ点

図形
Sonnetの emの
ABS ｽｨｰﾌﾟ 　　
300 のﾃﾞｰﾀ点11 点

(289 のﾃﾞｰﾀ点は捨てられる )

Adaptive Sweep
Settings
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戻されます。このﾁｪｯｸﾎﾞｯｸｽはﾃﾞﾌｫﾙﾄで選択されています。 ABS ｽｨｰﾌﾟは
実行したくないが、Microwave Officeで設定した必要な点で解析したい
だけなら、このﾁｪｯｸﾎﾞｯｸｽはｸﾘｱにします。

Full-Band: Microwave Officeで要求された Full Bandで ABS ｽｨｰﾌﾟを実行し
たい時に、このﾗｼﾞｵﾎﾞﾀﾝを選択します。この周波数帯は  Microwave 
Officeで要求された最低と最高の周波数で定義されます。このﾗｼﾞｵﾎﾞﾀﾝ
は、  Use Adaptive Band Synthesis ﾁｪｯｸﾎﾞｯｸｽが選択されている時のみ使用可
能です。これは ABS ｽｨｰﾌﾟではﾃﾞﾌｫﾙﾄ設定になっています。この
ﾁｪｯｸﾎﾞｯｸｽが選択されると、Sonnetの project editorの Analysis Setup 
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽ (Analysis ⇒ Setup) で、解析ｺﾝﾄﾛｰﾙは MWOffice Full-Band 
ABSになります。

Select-Band: Microwave Officeで要求された、異なる周波数帯域に渡って
ABS ｽｨｰﾌﾟを実行したい時に、このﾗｼﾞｵﾎﾞﾀﾝを選択します。これは、
ﾌﾙﾊﾞﾝﾄﾞの一部かﾌﾙﾊﾞﾝﾄﾞと重複するか、またはまったく異なる周波数帯
です。このﾗｼﾞｵﾎﾞﾀﾝは Use Adaptive Band Synthesis ﾁｪｯｸﾎﾞｯｸｽが選択され
ている時にのみ使用が可能です。このﾁｪｯｸﾎﾞｯｸｽが選択されると、Sonnet
の project editorの Analysis Setup ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽ (Analysis ⇒ Setup) の解析
ｺﾝﾄﾛｰﾙは Adaptive ｽｨｰﾌﾟ (ABS)で、周波数帯域はこのﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽで入
力されたものになります。

Microwave Office が、まだﾃﾞｰﾀがないために選択された帯域外の周波数
を要求している場合、emは選択された帯域の外にある要求された各ﾃﾞｰﾀ
点でﾌﾙ解析を行うことになることにご注意ください。これは、 EM のｼﾐ
ｭﾚｰｼｮﾝの計算時間がかなり長くなります。

Start:ここには所望の周波数帯域の最低周波数を入力します。これらの
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽは a Select-Band Adaptive Band Synthesis が選択されている時
にのみ使用が可能です。a Full-Band synthesis が選択されている場合は、
Microwave Office で要求された最低周波数がここに表示され、変更でき
ません。使用される単位は右側に表示されます。

Stop:ここには所望の周波数帯域の最高周波数を入力します。これらの
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽは、a Select-Band Adaptive Band Synthesis が選択されている
時にのみ使用が可能です。 a Full-Band synthesis が選択されている場合は、
Microwave Office で要求された最高周波数がここに表示され、変更でき
ません。使用される単位は右側に表示されます。
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Computing Current Density

Sonnet の解析で、ｼﾐｭﾚｰｼｮﾝの一環として電流密度ﾃﾞｰﾀを計算できる実行
ｵﾌﾟｼｮﾝがあります。 Compute Current Density ﾁｪｯｸﾎﾞｯｸｽを選択すると、こ
の実行ｵﾌﾟｼｮﾝが "on "になります。 Adaptive Band Sweepを実行中は、電流
密度ﾃﾞｰﾀは、すべての adaptive ﾃﾞｰﾀではなく、個々のﾃﾞｰﾀ点にのみ計算
されることにご注意ください。

NOTE: NOTE:  Sonnet で生成された電流密度ﾃﾞｰﾀは Sonnetの current density 
viewerで表示されるべきです。解析ｴﾝｼﾞﾝ emで生成された電流密度ﾃﾞｰﾀ
は、Microwave Office のﾌﾚｰﾑﾜｰｸとは互換性がありません。Sonnetが
ｼﾐｭﾚｰﾀとして選択されている時は、 Microwave Officeの Animate ﾒﾆｭｰ
のすべての選択項目は、使用できません。

Selecting the Run Option

Sonnetの解析の一部として電流密度ﾃﾞｰﾀを計算するには、次のようにし
ます。

1 所望の EM 構造 (解析ｼﾐｭﾚｰﾀに Sonnet を選択 )を右ｸﾘｯｸし、表示された
ﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから Options を選択します。

 Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが表示されます。



Sonnet User’s Guide

242

2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞの Sonnet Options ﾀﾌﾞをｸﾘｯｸします。

以下のように、 Sonnet optionsが表示されます。

3 Compute Current Density ﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸします。

Sonnet の解析が実行されると、電流密度ﾃﾞｰﾀがすべての個別の
ﾃﾞｰﾀﾎﾟｲﾝﾄについて計算されます。

4 OK ﾎﾞﾀﾝをｸﾘｯｸしてﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽをｸﾛｰｽﾞし、変更事項を適用します。

Viewing the Current Density Data

解析が終了して電流密度ﾃﾞｰﾀが得られると、View Currents ﾎﾞﾀﾝが使用可
能となります。このﾎﾞﾀﾝをｸﾘｯｸすると、 Sonnetの current density viewerが
ｵｰﾌﾟﾝし、電流密度ﾃﾞｰﾀを表示し、時間または周波数の関数でそれを
ｱﾆﾒｰｼｮﾝ表示することができます。

電流密度ﾃﾞｰﾀを表示するには、次のようにします。

1 ( 電流密度ﾃﾞｰﾀが計算された）所望の EM 構造を右ｸﾘｯｸし、表示された
ﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options” を選択します。

Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが表示されます。



Chapter 14  Microwave Office Interface

243

2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞ の Sonnet Options ﾀﾌﾞをｸﾘｯｸします。

以下のように、 Sonnet optionsが表示されます。

View Currents
ﾎﾞﾀﾝ



Sonnet User’s Guide

244

3 View Currents ﾎﾞﾀﾝをｸﾘｯｸします。

Current density viewerがｵｰﾌﾟﾝし、電流密度ﾃﾞｰﾀを表示し、時間または周
波数の関数でそれをｱﾆﾒｰｼｮﾝ表示することができます。 Current density 
viewerの使い方については、  Sonnetのｵﾝﾗｲﾝﾍﾙﾌﾟをご覧ください。Sonnet 
Tutorialの1つめのﾁｭｰﾄﾘｱﾙでも、 Current density viewerの使い方を説明して
います。

Saving the Current Density Data

Sonnetで計算した電流密度ﾃﾞｰﾀをMicrowave Officeのﾌﾟﾛｼﾞｪｸﾄの一部とし
て保存することもできます。次のようにします。

1 所望の EM 構造を右ｸﾘｯｸし、表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options” 
を選択します。

Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが表示されます。
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2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞの General ﾀﾌﾞをｸﾘｯｸします。

3 Currents ﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸして、ﾃﾞｰﾀを保存します。

このﾁｪｯｸﾎﾞｯｸｽが選択されると、解析後に Sonnetから戻された電流密度
ﾃﾞｰﾀが、 Microwave Officeのﾌﾟﾛｼﾞｪｸﾄの一部として格納されます。

Viewing the Subsectioning

完全な解析を実行する前に、回路の解析で Sonnet が使用するｻﾌﾞｾｸｼｮﾝ、
すなわちﾒｯｼｭを表示することができます。これは次のようにします。

1 所望の EM 構造を右ｸﾘｯｸし、表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから “Options” 
を選択します。

Options ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞが表示されます。
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2 ﾌﾟﾛﾊﾟﾃｨﾍﾟｰｼﾞ の Sonnet Options ﾀﾌﾞをｸﾘｯｸします。

以下のように、 Sonnet optionsが表示されます。

3 View Subsections ﾎﾞﾀﾝをｸﾘｯｸします。

これにより、 current density viewerとまったく同じ動きをする Sonnetの
subsection viewer が起動します。ある回路のｻﾌﾞｾｸｼｮﾆﾝｸﾞを以下に示しま
す。赤色は金属導体を示し、黒いｱｳﾄﾗｲﾝがｻﾌﾞｾｸｼｮﾝを示していることに
ご注意ください (見やすいように、図では色が変わっています )。

View Subsections
ﾎﾞﾀﾝ
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Executing the Analysis

Microwave Office ｳｨﾝﾄﾞｳのﾒｲﾝﾒﾆｭｰから Simulate ⇒ Analyze を選択すると、
EM構造を解析するために Sonnet が起動されます。Sonnetの解析を詳しく
示すﾌﾟﾛｸﾞﾚｽｳｨﾝﾄﾞｳが表示されます。

 “Keep this window open when finished” ﾁｪｯｸﾎﾞｯｸｽが選択されていなければ、
ｼﾐｭﾚｰｼｮﾝが終了すると、ｳｨﾝﾄﾞｳが閉じられます。Sonnetの解析が実行中
の時には、Microwave Office はﾛｯｸされているので、ﾌﾟﾛｼﾞｪｸﾄに対して変
更することはできないことにご注意ください。 Sonnet の解析でかなりの
計算時間がかかる場合は、Microwave Office はしばらくはﾛｯｸされます。
これを避けるためには、 EM 構造を Sonnet のﾌﾟﾛｼﾞｪｸﾄへｴｸｽﾎﾟｰﾄします。
そうすると、 EM 構造に変更を加えることができ、 Microwave Office の
ﾌﾟﾛｼﾞｪｸﾄをﾛｯｸせずに解析を実行できます。しかし、 EM 構造と残りの
ﾌﾟﾛｼﾞｪｸﾄを同期させるｵｰﾊﾞｰﾍｯﾄﾞがかかり、人為的なﾐｽを招くことにな
ります。 Import/Export ｵﾌﾟｼｮﾝについては、252 ﾍﾟｰｼﾞの "Working Outside 
Microwave Office"をご覧ください。
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Response Data
Sonnet を解析ｴﾝｼﾞﾝとして使う時は、Microwave Office で表示される電磁
界ｼﾐｭﾚｰﾀだけが、ﾎﾟｰﾄのﾊﾟﾗﾒｰﾀﾃﾞｰﾀ (S、 Y、 Z、ABCDなど )となります。
ﾒｯｼﾝｸﾞ、電流密度のﾌﾟﾛｯﾄ、遠方界の放射ﾊﾟﾀｰﾝはMicrowave Officeでは
使えません。Sonnet をｼﾐｭﾚｰｼｮﾝｴﾝｼﾞﾝとして選択すると、Microwave
Officeの Animation ﾒﾆｭｰは使用不可となります。電流や遠方界の放射
ﾊﾟﾀｰﾝを表示するには Sonnet を使わなくてはなりません。

Microwave Officeの Graph 機能を使って、ﾎﾟｰﾄのﾊﾟﾗﾒｰﾀﾃﾞｰﾀのｸﾞﾗﾌ（この
ﾃﾞｰﾀを使う式も含め）を作ることができます。

電流密度のﾌﾟﾛｯﾄや遠方界の放射ﾊﾟﾀｰﾝを表示するには、解析で電流密度
ﾃﾞｰﾀを計算しなくてはなりません。電流密度のﾌｫｰﾏｯﾄはMicrowave 
Officeと Sonnetでは異なるので、 Sonnet のﾓｼﾞｭｰﾙを使って電流密度を表示
しなくてはなりません。  242 ﾍﾟｰｼﾞの "Viewing the Current Density Data"を
ご覧ください。

Sonnet はまた、電流密度ﾃﾞｰﾀを使って遠方界の放射ﾊﾟﾀｰﾝを計算します。
Sonnet の解析で作られた電流密度ﾃﾞｰﾀがある場合は、Sonnetの far field 
viewerを使ってそのﾊﾟﾀｰﾝを表示できます。  Sonnetの far field viewerを使う
には、解析が終了したら、Sonnetの project editor 、Native Editorで EM 構
造をｵｰﾌﾟﾝします。、次に project editorのﾒｲﾝﾒﾆｭｰから Project ⇒ View Far 
Field を選択します。このﾌﾟﾛｸﾞﾗﾑでﾃﾞｰﾀを表示する方法については、
ｵﾝﾗｲﾝﾍﾙﾌﾟをご覧ください。
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Editing in Sonnet’s Project Editor
 Sonnetを解析ｴﾝｼﾞﾝに選択している時は、  EM 構造をどこで編集するか選
ぶことになります。 Microwave Office か、または Microwave Office で
Native Editor と呼んでいる、この場合、 Sonnetの project editorかを選びま
す。次の節では、 Native Editorつまり Sonnetの project editorで構造を編集
する方法を説明します。

! WARNING
ｴﾃﾞｨﾀを Native Editor から Microwave Office Editorに変更することを選
択する場合、図形での Sonnet の仕様の変更は永久に削除されます。再び
Native Editorを選ぶ場合は、これらの図形の変更事項を再入力しなくて
はなりません。

Sonnetに特有な thick metal、誘電体ﾌﾞﾘｯｸ、または autogrounded ﾎﾟｰﾄのよ
うな機能を利用したい時には、Sonnetの project editorで EM構造を編集
します (Sonnetで利用できる機能の全ﾘｽﾄは 255 ﾍﾟｰｼﾞの "Translation 
Issues"をご覧ください)。 Sonnetのproject editorでEM構造を編集するため
には、ﾕｰｻﾞは既に Sonnet のｿﾌﾄｳｪｱを使い慣れているか、そうでない場合
は、 Sonnet の環境に精通するために、Sonnet のﾏﾆｭｱﾙを使う必要がありま
す。

Native Editor (つまり Sonnetの project editor)を使うことにした場合は、回
路の仕様を含んだ Sonnet のﾌﾟﾛｼﾞｪｸﾄが Microwave Office のﾌﾟﾛｼﾞｪｸﾄﾌｧｲﾙ
(.emp)の一部として格納されます。Project editorで EM構造をｵｰﾌﾟﾝした時
か、解析を要求した時に、 EM 構造のための図形の仕様は Sonnetへ送ら
れます。回路への変更が終わり、その変更事項を保存して Sonnetを終了
すると、回路の仕様がMicrowave Office へ戻され、Microwave Office の
ﾌﾟﾛｼﾞｪｸﾄの一部として格納されます。解析が実行されていると、その結
果も Sonnet のﾌﾟﾛｼﾞｪｸﾄとともに格納されます。
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NOTE: Sonnetの解析から得た電流密度ﾃﾞｰﾀをﾌﾟﾛｼﾞｪｸﾄの一部として格納したい
場合は、 Microwave Officeの Options ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの General ﾀﾌﾞにあ
る “Currents” ﾁｪｯｸﾎﾞｯｸｽを選択する必要があります。 244 ﾍﾟｰｼﾞの
"Saving the Current Density Data "をご覧ください。

Native Editor ｵﾌﾟｼｮﾝを選択し、 Sonnetの project editorでEM構造を編集する
には、 EM構造を右ｸﾘｯｸし、表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから Open in Native 
Editor を選択します。

これにより、 Sonnetの ｸﾞﾗﾌｨｯｸ･ｴﾃﾞｨﾀが起動されます。Sonnetで EM 構造
がｵｰﾌﾟﾝされると、Sonnetの project editor がｸﾛｰｽﾞされるまでMicrowave
Officeのﾌﾟﾛｼﾞｪｸﾄはﾛｯｸされます。

NOTE: Project editorにｸﾗｯｼｭや他の突然の中断が生じた場合は、ﾌﾟﾛｸﾞﾗﾑは
MWOfficeをﾛｯｸせずに終了するかもしれません。その場合、ﾊﾝｸﾞ状態に
見える MWOffice を手でﾛｯｸ解除する必要があります。 MWOfficeのﾛｯｸ
解除については、263 ﾍﾟｰｼﾞの "Unlocking Microwave Office"をご覧く
ださい。

! WARNING
EM構造への変更を終えた後に、Sonnetの project editor  をｸﾛｰｽﾞする時に
Sonnet をﾃﾞﾌｫﾙﾄのｴﾃﾞｨﾀにしたいかと聞いてきたら、 “Yes” と答えてくだ
さい。そうすると、 Sonnetの project editorで行った変更事項は失われま
せん。
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Microwave Officeで、EM構造にOptions ﾍﾟｰｼﾞの General ﾀﾌﾞでNative Editor
を選択して、Sonnet のｴﾃﾞｨﾀを選ぶこともできます。こうすると、 Sonnet 
でｾｯｼｮﾝを終える時にﾌﾟﾛﾝﾌﾟﾄが出されず、行った変更は自動的に保存さ
れます。

Sonnet で編集をすると、ﾕｰｻﾞは Sonnet のｴﾝｼﾞﾝのすべての機能を使うこ
とができます。ﾕｰｻﾞはその解析結果でMicrowave Office の環境へ戻る前
に、回路をｼﾐｭﾚｰｼｮﾝし、電流密度ﾃﾞｰﾀと遠方界ﾊﾟﾀｰﾝを含むすべての
ﾀｲﾌﾟの応答ﾃﾞｰﾀを表示することができます。

Sonnetで EM 構造を編集中は、 Microwave Office での表示は正確でないか
もしれないことを覚えておくことが大切です。Sonnet をｴﾃﾞｨﾀに使用し
ている時は、 EM 構造は  Microwave Officeでは使用できないｵﾌﾞｼﾞｪｸﾄや機
能を含んでいるかもしれません。従って、回路はMicrowave Officeで表
示されている時には、正しく描かれていないかもしれません。 Sonnetの
project editorで EM構造をｵｰﾌﾟﾝすると、その回路は正確に描写されます。

Native Editorが選択されている時に、 Microwave Officeで EM構造をｵｰﾌﾟﾝ
していると、その構造に変更が行えないかもしれません。回路は  Read 
Only ﾓｰﾄﾞでｵｰﾌﾟﾝされます。
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Microwave Officeに戻る前に Sonnet で回路を解析できますし、またはそ
の解析は Microwave Officeから実行することができます。しかし、
Sonnet で解析を実行した場合には、Microwave Officeでもまた解析しなく
てはならないことにご注意ください。結果が既に得られているので、
EM構造の解析は大変早いのですが、 Microwave Office の解析ｺﾏﾝﾄﾞは、
Sonnetから所望の応答ﾃﾞｰﾀを持ってくることになります。

TIP
Microwave Office のﾌﾟﾛｼﾞｪｸﾄに複数の EM 構造がある場合、Sonnetで複数
の解析ｺﾏﾝﾄﾞを実行し、更にMicrowave Office で完全な回路を解析しなく
てはならないということを避けるために、Microwave Officeでｼﾐｭﾚｰｼｮﾝ
を実行する方がより容易です。

Microwave Office のｿﾌﾄｳｪｱから Sonnet のｿﾌﾄｳｪｱへの変換(その逆も)にも
ご注意ください。これらの変換の問題点については 255 ﾍﾟｰｼﾞの
"Translation Issues"をご覧ください。

Working Outside Microwave Office
Microwave Officeで、 Sonnetの Native Editor を使って回路を編集する時は、
Sonnetの project editorがｵｰﾌﾟﾝしている間はMicrowave Officeはﾛｯｸされて
います。これは、解析に時間がかからない比較的小さな EM構造には問
題ありませんが、解析にかなりの時間がかかる大きな回路では、
Microwave Office がﾛｯｸｱｳﾄしていることは、問題となりますし、 EM 構造
をｴｸｽﾎﾟｰﾄすると、 Microwave Officeのﾌﾚｰﾑﾜｰｸを使いながら、Sonnetの解
析を実行することができます。しかし、その変換とMicrowave Officeの
EM構造と Sonnet のﾌﾟﾛｼﾞｪｸﾄが一致するのにかなりのｵｰﾊﾞｰﾍｯﾄﾞがありま
す。

Exporting Your EM Structure to Sonnet

Microwave Officeのﾌﾚｰﾑﾜｰｸの外で作業をするには、まず次のように、 EM 
構造を Sonnet のﾌﾟﾛｼﾞｪｸﾄへｴｸｽﾎﾟｰﾄします。
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1 Native Editorで  EM 構造をｵｰﾌﾟﾝします。

 EM 構造が Sonnetの project editorでｵｰﾌﾟﾝします。 Microwave Office は
project editorがｸﾛｰｽﾞされるまでﾛｯｸされています。

2 Sonnetの project editorのﾒｲﾝﾒﾆｭｰから File ⇒ MWOffice ⇒ Save As Sonnet 
Project を選択します。

ﾌﾞﾗｳｻﾞｳｨﾝﾄﾞｳが表示されます。

3 EM構造から作成している Sonnet のﾌﾟﾛｼﾞｪｸﾄの名前とﾛｹｰｼｮﾝを選択しま
す。

EM構造は指定されたﾛｹｰｼｮﾝで、Sonnet のﾌﾟﾛｼﾞｪｸﾄとして保存されます。

4 ﾒｲﾝﾒﾆｭｰから File ⇒ Exitを選択して project editorを終了します。

これで project editor がｸﾛｰｽﾞされ、Microwave Officeがﾛｯｸ解除されます。

次に、回路が設計の基準を満たすまで Sonnet で回路を編集し解析しま
す。これが完了したら、project editorで  Load Sonnet Project ｺﾏﾝﾄﾞを使用
して SonnetのﾌﾟﾛｼﾞｪｸﾄをMicrowave Officeの EM構造へｲﾝﾎﾟｰﾄします。
詳細は 254 ﾍﾟｰｼﾞの "Importing a Sonnet Project"をご覧ください。

Analyzing Outside Microwave Office

EMの解析中に Microwave Office の外で作業をする 2つめの方法は、
Sonnetの project editorで Analyze Outside MWOffice ｺﾏﾝﾄﾞを使うことです。
いったん解析が始まると、project editorを終了させてMicrowave Officeを
ﾛｯｸ解除できますが、このｺﾏﾝﾄﾞを使うと、同様に project editorから解析
を起動できます。このｺﾏﾝﾄﾞの使用中に、 EM構造に一時的な Sonnet の
ﾌﾟﾛｼﾞｪｸﾄﾌｧｲﾙを指定します。解析が終了すると、一時的な Sonnetの
ﾌﾟﾛｼﾞｪｸﾄを Microwave Officeにｲﾝﾎﾟｰﾄする必要があります。

Microwave Officeの外で解析をするには、次のようにします。

1 Native Editorで  EM 構造をｵｰﾌﾟﾝします。

EM構造を表示した Sonnetの project editor がｵｰﾌﾟﾝします。
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2 Project editorのﾒｲﾝﾒﾆｭｰから File ⇒ MWOffice ⇒ Analyze Outside 
MWOffice  を選択します。

 Hints Preferencesのﾒｯｾｰｼﾞを "off "にしてなければ、そのｺﾏﾝﾄﾞを説明する
ﾒｯｾｰｼﾞが表示されます。

3 OK ﾎﾞﾀﾝをｸﾘｯｸしてそのﾒｯｾｰｼﾞをｸﾛｰｽﾞします。

ﾌﾞﾗｳｻﾞｳｨﾝﾄﾞｳが表示され、EM構造がｴｸｽﾎﾟｰﾄされ、その解析が行われる
Sonnet のﾌﾟﾛｼﾞｪｸﾄの一時的なﾛｹｰｼｮﾝを選択することができます。

4 EM構造を保存したい Sonnet のﾌﾟﾛｼﾞｪｸﾄの名前とﾛｹｰｼｮﾝを選択します。

これで、今表示されている変換された EM 構造が、Sonnet のﾌﾟﾛｼﾞｪｸﾄと
して project editor に保存され、 EM の解析が始まります。

5 解析は開始されたことを示す解析ﾓﾆﾀｰが表示されたら、File => Exitを選
択して project editor を終了することができます。

6 Project editor がｸﾛｰｽﾞされ、  Microwave Officeがﾛｯｸ解除されます。

 Sonnetで解析が終了したら、一時的なﾌﾟﾛｼﾞｪｸﾄと解析結果をｲﾝﾎﾟｰﾄする
必要があります。これをするには、254 ﾍﾟｰｼﾞの "Importing a Sonnet 
Project"をご覧ください。

Importing a Sonnet Project

上で述べたﾌﾟﾛｼﾞｪｸﾄをｴｸｽﾎﾟｰﾄする方法と、 Microwave officeの外で解析
を行う方法はともに project editorの中で EM構造をｵｰﾌﾟﾝし、 Load ｺﾏﾝﾄﾞ
を選択することによって EM 構造のｱｯﾌﾟﾃﾞｰﾄを明確に実行することがで
きます。Project editorをｸﾛｰｽﾞすると、Sonnet のﾌﾟﾛｼﾞｪｸﾄの内容は解析結
果とともにMicrowave Officeに戻されます。

Sonnet のﾌﾟﾛｼﾞｪｸﾄをMicrowave Officeにｲﾝﾎﾟｰﾄするには、次のようにしま
す。

1 もとの EM構造がもって来られた Microwave Office をｵｰﾌﾟﾝします。
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2 EM構造を右ｸﾘｯｸし、表示されたﾎﾟｯﾌﾟｱｯﾌﾟﾒﾆｭｰから ''Open in Native 
Editor''を選択します。

選択された EM構造の上に project editor がｵｰﾌﾟﾝします。

3 Project editorのﾒｲﾝﾒﾆｭｰからFile ⇒ MWOffice ⇒ Load Sonnet Project を選
択します。

4 ﾌﾞﾗｳｻﾞｳｨﾝﾄﾞｳが表示されたら、 Microwave Officeへｲﾝﾎﾟｰﾄしたい Sonnet 
のﾌﾟﾛｼﾞｪｸﾄを選択します。

Project editorを終了すると、 Sonnet のﾌﾟﾛｼﾞｪｸﾄがMicrowave Office へ
ｲﾝﾎﾟｰﾄされます。しかし、解析がMicrowave Officeで実行されている時
だけ、応答ﾃﾞｰﾀがｲﾝﾎﾟｰﾄされることにご注意ください。

Translation Issues
Microwave Office と Sonnet がともに変換しないいくつかの機能と
Microwave Office Interfaceを使い始める前に知っておくべき変換について
の問題点があります。それらをすべて以下で説明します。
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Sonnet Features Not Available in Microwave Office

これらの機能は、ﾕｰｻﾞが EM構造の編集に Microwave Officeを使ってい
るか、Sonnetの project editor (Native Editor)を使っているかによって扱い
方が異なります。下の表は、Microwave Officeでは使用できない Sonnet 
の機能とその機能が各ｴﾃﾞｨﾀでどう取り扱われるかを列挙します。

! WARNING
Microwave Officeで編集中に変換や消去が生じたら、  EM 構造を project
editorでｵｰﾌﾟﾝすると、その変更は永久なものであり復元されません。

Sonnet Feature Edit in Microwave Office Edit in Sonnet’s Project 
Editor

Thick Metal metal type 薄い金属に変換される。 回路には残されるがMicro-
wave Officeでは薄い金属に表
示される。

Dimensions 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Subdividers 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Parameters 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Parallel Subsections 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Linked Reference Planes 固定された長さの参照面に
変換される。

Microwave Officeでは固定さ
れた長さの参照面に変換さ
れる。

Calibration Lengths 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。
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Edge Vias 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Circular and Polygon Vias 矩形の viaに変換される。 回路には残されるが
MWOfficeでは矩形の via と
して表示される。

Symmetry 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Dielectric Bricks 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Relative magnetic permeabil-
ity (Mrel) and magnetic loss 
tangent (Mag Loss Tan) for 
Dielectric Layers

Mrelは 1に、 Mag Loss Tan 
は 0に設定される。

回路には残されるがMicro-
wave Officeでは表示されない。

Dielectric Layer Names 図形から削除される。 回路には残されるがMicro-
wave Officeでは表示されない。

Capacitance and Inductance 
in Port definitions

ｷｬﾊﾟｼﾀﾝｽとｲﾝﾀﾞｸﾀﾝｽは 0に
設定される。

回路には残されるがMicro-
wave Officeでは表示されない。

Inductance (Ls) for metals ｾﾞﾛの値に設定される。 回路には残されるがMicro-
wave Officeでは表示されない。

Comments 図形から削除される。 回路には残されるがMicro-
wave Officeでは使えない。

Metal Types 258ﾍﾟｰｼﾞの"Metal Types" を
参照。

258ﾍﾟｰｼﾞの"Metal Types" を
参照。

Port Mapping 260 ﾍﾟｰｼﾞの "Port Mapping" 
を参照。

260 ﾍﾟｰｼﾞの "Port Mapping" 
を参照。

Ports on Ground Plane 261 ﾍﾟｰｼﾞの "Port on Ground 
Plane"を参照。

261 ﾍﾟｰｼﾞの "Port on Ground 
Plane"を参照。

Sonnet Feature Edit in Microwave Office Edit in Sonnet’s Project 
Editor
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Metal Types

Models

Sonnetには 6つの異なる金属ﾀｲﾌﾟのﾓﾃﾞﾙがあります。 : Normal、 Resistor、
Rdc/Rrf、 General、 Sense Metal 、 Thick Metal Modelです。各ﾓﾃﾞﾙには異なる
一組のﾊﾟﾗﾒｰﾀがあります。Sonnetのﾌﾟﾛｼﾞｪｸﾄが Microwave Officeに
ｲﾝﾎﾟｰﾄされる時は、Microwave Office と Sonnetの解析で同じ損失の特徴
となるようにﾊﾟﾗﾒｰﾀの  Rdc、 Rrf、 Xdc ( それぞれ DC抵抗、表皮効果、 DC 
ﾘｱｸﾀﾝｽ ) を使って等価ﾓﾃﾞﾙに変換されます。これは、Sonnetでは General 
金属ﾀｲﾌﾟのｲﾝﾀﾞｸﾀﾝｽ  Lsが常にｾﾞﾛに設定されているものと同じです。

Native Editorつまり、 Sonnetの project editorをお使いの場合は、金属ﾀｲﾌﾟ
は、Sonnet ﾌﾟﾛｼﾞｪｸﾄでの定義のままですが、これがMicrowave Officeで
表示される時は、そのﾊﾟﾗﾒｰﾀは Rdc、 Rrf、  Xdcの 3つのﾊﾟﾗﾒｰﾀに変換さ
れます。Sonnetで使用されていたﾊﾟﾗﾒｰﾀは表示されません。金属ﾀｲﾌﾟは
同じ名前で、  Microwave Office ﾌﾟﾛｼﾞｪｸﾄﾌﾞﾗｳｻﾞでは、 EM Structure ﾌｫﾙﾀﾞの
Materialsに表示され、 Sonnetのproject editorでは、 metal typesに表示されま
す。

Port Termination and Excita-
tion

261 ﾍﾟｰｼﾞの "Port Termina-
tion and Excitation"を参照。

261 ﾍﾟｰｼﾞの "Port Termina-
tion and Excitation"を参照。

Off Grid Placement 262 ﾍﾟｰｼﾞの "Off Grid Place-
ment "を参照。

262 ﾍﾟｰｼﾞの "Off Grid Place-
ment "を参照。

Coordinate System 262ﾍﾟｰｼﾞの"Coordinate Sys-
tem"を参照。

262ﾍﾟｰｼﾞの"Coordinate Sys-
tem"を参照。

Sonnet Feature Edit in Microwave Office Edit in Sonnet’s Project 
Editor
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下図は Sonnetの Metal Types ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽで、ここには定義された追加
された 3つの金属と、 Microwave Officeで表示された同じ材質が表示され
ています。Sonnetではこの 3つの金属は Normal ﾓｰﾄﾞを使っていますが、
このﾓｰﾄﾞはMicrowave Officeでは、 Rdc、 Rrf、 Xdc のﾊﾟﾗﾒｰﾀに変換される
ことにご注意下さい。

Loss

 Sonnet で無損失でない金属ﾀｲﾌﾟを定義すると、その金属ﾀｲﾌﾟは、
Microwave Officeでは、EM構造がMicrowave Officeに戻される時に
Materials ﾘｽﾄに追加されます。その後、  Sonnet でその金属ﾀｲﾌﾟに損失の定
義を変更する場合は、次の 2つのうち 1つが起こります。

• ある金属ﾀｲﾌﾟの定義を始めの定義とは異なる損失のある
ﾊﾟﾗﾒｰﾀになるように変更する場合は、 Microwave Office では
もとの名前の後ろに “X” のついた名前の新しい材質が作ら
れます。例えば、 Goldという名の材質があって、その損失の
ﾊﾟﾗﾒｰﾀを Sonnetで修正する場合、編集の最後のｾｯｼｮﾝで
Sonnetから回路を入力した時にMicrowave Office で作られる
新しい材質名は GoldXとなります。

• ある金属ﾀｲﾌﾟの定義を無損失の金属に変更する場合は、その
金属ﾀｲﾌﾟを使用しているどの図形も EM 構造が  Microwave 
Officeに戻される時にﾃﾞﾌｫﾙﾄの無損失の金属ﾀｲﾌﾟに変えられ
ます。Microwave Officeで呼ばれている金属ﾀｲﾌﾟまたは材質
は Microwave Office内で使われている同じ名前です。
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どちらの場合も、これらの変更は Microwave Officeでは EM構造の表示
にのみ影響します。図形は Sonnetで再びｵｰﾌﾟﾝされた時には、金属ﾀｲﾌﾟ
とその定義はそのままです。

Adding, Changing or Deleting Metal Types

Native Editorでの編集中にある金属ﾀｲﾌﾟを削除したい場合は、 Sonnetと
Microwave Office の両方の環境でこれを行う必要があります。Sonnet の
ﾌﾟﾛｼﾞｪｸﾄから金属ﾀｲﾌﾟを削除しても Microwave Officeでは、これは自動
的に EM Structures Materials ﾘｽﾄから削除されません。

Port Mapping

Microwave Office はﾎﾟｰﾄには 1の値で始まる連続した数しか使えません。
ﾎﾟｰﾄ番号は、正の整数でなくてはなりません。 Sonnet はとびとびや重複
したﾎﾟｰﾄ番号が使え、また負の数のﾎﾟｰﾄ番号も使えます。 Sonnetの解析
ｴﾝｼﾞﾝ、emは同じ正のﾎﾟｰﾄ番号を持つすべてのﾎﾟｰﾄに流れる電流の総和
をとり、同じ負のﾎﾟｰﾄ番号を持つすべてのﾎﾟｰﾄから出る総電流に等しく
なるように設定しす。

EM構造がMicrowave Officeから Sonnetに送られると、Sonnet は
Microwave Officeから Sonnetへ移ることには何の問題もありません。

Sonnetの project editorを使って EM構造を編集する Native Editor ﾓｰﾄﾞで
Sonnetを使っている場合は、とびとびのﾎﾟｰﾄ番号と負の数のﾎﾟｰﾄ番号を
入力できます。 Sonnetで入力されたﾎﾟｰﾄ番号は、 Microwave Office の
ﾌﾟﾛｼﾞｪｸﾄで保存された Sonnetのﾌﾟﾛｼﾞｪｸﾄﾌｧｲﾙの一部として残されます
が、Sonnet の環境でのみ正しく表示されます。このﾎﾟｰﾄは Sonnet で昇順
でﾎﾟｰﾄをﾏｯﾋﾟﾝｸﾞし、負の数と重複したﾎﾟｰﾄ番号を削除して、  Microwave 
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Officeで表示できるように連続した数にします。例えば、  Sonnet の
ﾌﾟﾛｼﾞｪｸﾄがﾎﾟｰﾄ番号に 1、 4、 -4、  7を使用していると、このﾌﾟﾛｼﾞｪｸﾄが
Microwave Office の環境内で変換されると、下の表のように変わります。

Ports on Ground Plane

Sonnet ではｸﾞﾗｳﾝﾄﾞ面にﾎﾟｰﾄを置くことができます。  Microwave Office で
は、これは解析ができなくなるので、ｴﾗｰ条件となります。 Microwave 
Officeではｸﾞﾗｳﾝﾄﾞ面のﾎﾟｰﾄはｸﾞﾗｳﾝﾄﾞ面 ( 基板 )から上のﾚﾍﾞﾙへ伸びる
via ﾎﾟｰﾄに変換されます。

Port Termination and Excitation

ﾎﾟｰﾄはMicrowave Officeでは 2通りの方法で定義されます。終端と励振
です。ﾎﾟｰﾄの終端は実数と虚数部で定義します。これは、ﾎﾟｰﾄの
Resistanceと Reactance のﾊﾟﾗﾒｰﾀとして直接 Sonnetに変換します。
Microwave Officeでは、Sonnetとは異なり、ﾎﾟｰﾄのｲﾝﾀﾞｸﾀﾝｽとｷｬﾊﾟｼﾀﾝｽを
定義できません。Microwave Office をｴﾃﾞｨﾀに使用している時は、これら
の値は 0に設定されます。Native Editorを使用している時は、ｲﾝﾀﾞｸﾀﾝｽ
とｷｬﾊﾟｼﾀﾝｽをに値を入力します。それらは、 Sonnet のﾌﾟﾛｼﾞｪｸﾄの一部と
して保存されますがMicrowave Officeでは表示されません。

Sonnet Port 
Number MWOffice Port Number

1 1

4 2

-4 なし。ﾎﾟｰﾄは削除される。

7 3
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Microwave Officeでは、 Available Power と Phaseを入力して回路のﾎﾟｰﾄの励
振を定義することができます。 Sonnet では、 project editorでﾎﾟｰﾄの励振を
定義することはできません。従って、EM構造が Sonnetの中に変換され
る場合は、これらの値はﾎﾟｰﾄのために削除され、終端の定義が使用され
ます。

Sonnet は、 current density viewer と far field viewerの両方にﾎﾟｰﾄの励振がで
きます。詳しくはどちらかのﾌﾟﾛｸﾞﾗﾑのｵﾝﾗｲﾝﾍﾙﾌﾟをご覧ください。

Off Grid Placement

Microwave Officeのｸﾞﾘｯﾄﾞの点と点の分解能は 1/20 ｾﾙです。Sonnet では
もっと細かい分解能を使用しています。従って、ｸﾞﾘｯﾄﾞから離れた図形
の位置を変更する場合、EM構造を Microwave Officeに戻した時は、配
置が若干異なるかもしれません。

Coordinate System

Microwave Office と Sonnetとでは異なる座標系を使っています。  Sonnet の
原点 (0,0)は、基板の左下にありますが、 Microwave Office ではｸﾞﾗｳﾝﾄﾞ面
と呼んでいる基板の左上にあります。

3D Viewer Scaling

Microwave Officeの 3D viewerには誘電体層を設定するｽｹｰﾙがあり、他の
誘電体層に比べて、大きな誘電体層を表示することができます。Native 
Editor ﾓｰﾄﾞで、Sonnetで EM 構造をｵｰﾌﾟﾝする場合には  3D viewer のｽｹｰﾙを
設定する方法はありません。
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Meshing, Current Density Plots and Far Field Plots

Sonnet を解析ｴﾝｼﾞﾝに使うと、Microwave Officeでﾒｯｼﾝｸﾞや電流密度
ﾌﾟﾛｯﾄ、遠方界放射のｸﾞﾗﾌを表示することができません。Sonnetが解析
ｴﾝｼﾞﾝに選択されている時は、Microwave Officeの Animation ﾒﾆｭｰは使え
ません。Sonnetでこのﾃﾞｰﾀを表示することについては、  248 ﾍﾟｰｼﾞの
"Response Data "をご覧ください。

Troubleshooting
Unlocking Microwave Office

Microwave Officeから Sonnetの project editor をｵｰﾌﾟﾝすると、 Microwave 
Officeはﾕｰｻﾞが project editorをｸﾛｰｽﾞするまでﾛｯｸされます。Sonnetが
ｸﾛｰｽﾞされてMicrowave Office がﾛｯｸ解除されるまで、Microwave Officeの
どのｺﾏﾝﾄﾞも、変更したり実行することができません。 Sonnet と
Microwave Officeとのやりとりは、 Sonnet のﾌﾟﾛｸﾞﾗﾑ、sonntawrを通して行
われます。  Sonnet をｸﾛｰｽﾞすると、,sonntawrは Microwave Office にﾛｯｸ解
除を知らせます。

ある理由で、ﾊﾝｸﾞﾌﾟﾛｸﾞﾗﾑやﾌﾟﾛｸﾞﾗﾑｸﾗｯｼｭのような graceful shutdown( 行
儀よい終了 )を防ぐような方法で、Sonnet のﾌﾟﾛｸﾞﾗﾑが中断された場合、
Microwave Office はﾛｯｸ解除されません。 Project editor (xgeom) が既に動い
ていないのに、Microwave Officeがまだﾛｯｸされている場合は、
Sonnet ﾀｽｸﾊﾞｰのﾒｲﾝﾒﾆｭｰから Admin ⇒ MWOffice Interface ⇒ Unlock 
MWOfficeを選択して、手でこれをﾛｯｸ解除します。 Sonnet ﾀｽｸﾊﾞｰをｵｰﾌﾟﾝ
するには、Windowsのﾃﾞｽｸﾄｯﾌﾟﾒﾆｭｰから、ｽﾀｰﾄ⇒ ﾌﾟﾛｸﾞﾗﾑ⇒Sonnet ⇒ 
Sonnet を選択します。

Project Editor does not open due to a licensing problem

Microwave Officeから Native Editor をｵｰﾌﾟﾝすると、 project editor は
Microwave Office にﾛｯｸﾒｯｾｰｼﾞを送る前にﾗｲｾﾝｽを得ようと試みます。
Project editor がﾗｲｾﾝｽの取得に失敗すると、ﾛｯｸﾒｯｾｰｼﾞは送られません。
Microwave Office はﾛｯｸﾒｯｾｰｼﾞを送るﾀｲﾐﾝｸﾞの前に 1分間待ち、この間反
応はできません。
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Coordinate System

Microwave Office と Sonnetとでは異なる座標系を使っています。  Sonnet の
原点 (0,0)は、基板の左下にありますが、 Microwave Office ではｸﾞﾗｳﾝﾄﾞ面
と呼んでいる基板の左上にあります。ｸﾞﾘｯﾄﾞの位置を指定するｴﾗｰﾒｯｾｰｼﾞ
を受け取った場合は、このことを覚えておくことが大切です。 Sonnet か
ら出されるｴﾗｰﾒｯｾｰｼﾞは、  Sonnet の座標がもとになっていますが、ｴﾗｰの
原因を効果的に診断するためには、 Microwave Office の座標に変換される
必要があるかもしれません。


